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At our September meeting, we enjoyed a
fabulous presentation by one of our long time
members, Sam Storch. Sam is a Professor
of Astronomy at several colleges, including
Nassau Community College. He is also the
administrator of the Hubble Planetarium
(1600 Ave. L, Brooklyn, NY). He has a broad
knowledge of astronomy software for the Mac
including software that will run quite well on
older Macs running OS 8.6 and 9.x.
Sam’s program was entitled, The Universe
From Your Mac. He started by discussing the
most popular program today which is Starry
Night Pro. There are many versions of Starry
Night depending on your needs and budget.
People always say, “you had to be there,” well,
in this case you really did. Words can not
describe what this application can show you.
You can choose any star, planet, the moon, or
any cluster of stars, zoom in on the object or
objects and see close up details. It will also
display the known information about the
object. Sam also showed us similar programs,
one called Voyager 4, and the other – a free
program called Stellarium. Starry Night Pro
version 4.5 is recommended for its relatively low
system requirements. It will work well with
OS X 10.2 or better, and with moderately old
hardware such as a 500 MHz iMac. Sam also
pointed out that the newer versions are not
really necessary for most users, because version 4.5 will do just about anything you might
want. Voyager is very good if you want to use
it to control a telescope. For a free program,
Stellarium was very impressive, and it also does
not require more than a 500 MHz iMac.
Next, Sam discussed some application
that had very speciﬁc uses. Such as:
| Deep Space Explorer, which is good for
zooming in on things. It performed surprisingly fast.
| Where is M13? – it gives you an idea where
things are.
| HourWorld, a time zone program.
| InterCal shows dates on different calendars.
Everyone had a great time. We all were
really impressed with his knowledge of
astronomy, and of all the available software. I
would say I speak for all who attended, that we
will look forward to him treating us to another
presentation.
–Scott Randell

Adam C. Engst, the publisher of TidBITS and the
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will be taking us on a tour
through the most useful
new features in Apple’s
iPhoto 6, part of iLife
’06. He’ll look at iPhoto’s
new full-screen editing mode;
editing capabilities; photocasting; cards and
calendars; iWeb integration; and improvements
to books, printing, and smart albums. And
because Adam doesn’t work for Apple, he’ll even
show us where the iPhoto team has continued
to drop the ball, missing the opportunity for
new features that would be useful for all iPhoto
users. He and his wife, Tonya, will also update
the group on their Take Control ebook series,
which are available to LIMac members at 10% off,
and rafﬂe off copies of Adam’s “iPhoto 6: Visual
QuickStart Guide” and a complete CD library of
all 40 Take Control ebooks. 0
–Rick Matteson
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September’s Door Prize Winner.
Everyone who came to the meeting in
September was given one free door prize ticket,
and the winner was Bradley Dichter who, in
fitting with our nighttime astronomy theme,
won a twin-pack of night lights. 0
General meeting time schedule:
Meetings are held at The New York Institute of Technology,
Building 300 (Anna Rubin Hall), Old Westbury. Long Island.
Meetings start promptly at 7:00 p.m.
Bradley Q&A 7:00–7:30 p.m. Beginner’s Q&A 7:00–7:30 p.m.
Featured presentation 7:30–8:20 p.m.
followed by announcements/rafﬂe drawing
SIG (Special Interest Group) meetings 8:30–10:00 p.m.
Photoshop SIG: How to Use Photoshop’s Sharpening Tools: What’s the
difference between Sharpen, Sharpen Edges, Sharpen More, Unsharp
Mask and the newest Smart Sharpen?
Multimedia SIG: Al Zygier will show “From iMovie to Final Cut Pro review”!
MacBasics SIG: We’ll continue delving into OS X and look at some of the
small applications and utilities which
come with the OS and will include brief
demonstrations of Address Book, Calculator,
Dictionary, DVD Player, iCal, iChat, Image
Capture, Stickies and TextEdit.
| In bad weather, call (516) 686-7789.
| The next LIMac board meeting
will be at the Plainedge Library,
(516) 735-4133, on Wednesday,
October 18th, at 8 p.m.
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Set multiple folder views via Automator
By Rob Griffiths
Do you prefer to use one type of Finder window,
and only one type? If so, you’re probably somewhat frustrated by OS X’s ability to seemingly
randomly pick a different view. You like using
icons, for instance, but find that some folders in
your home folder open in list or column view. Sure,
you can change each one as it opens, but that’s

a bit of a pain. If you’ve upgraded to 10.4, there’s
a simple solution available, thanks to Automator.
Obviously, the following steps could be used for
any folder on your machine, but we’ll use your
user’s folder for this example.
First, make sure you can see your user’s folder
in the Finder. The easiest way to do this is to click
on your computer’s name in the sidebar, or click
on your home folder and then hit Command-Up

Bradley’s Tech Session

Arrow. You should now see your actual user’s
folder, along with those of any other users you’ve
created on your system. Leave this window open,
then launch Automator, in /Applications. Position
the Automator window and the Finder window
you left open such that you can see both at once.
Now drag and drop your user’s folder into the
blank area on the right side of the Automator
window. If you don’t have enough screen space

to see both windows, switch to the Finder, click
and hold on your user’s folder, then hit F9 to
activate Exposé, drag your user’s folder over the
Automator window, hit F9 again (or just wait a
second), then drop the folder.
Next, still in Automator, click on the Finder
item in the Library column, and then drag Set
Folder Views from the Actions column into the
right-hand workspace. Drag and drop it below the

President’s Message

| I use Mozilla because it includes an e-mail
I just received some good news: the CAD proclient, but I’ve been having problems with
gram that I use is up to twice as fast on the new
my cookies. What can I do?
Xeon Quad Mac Pro workstations from Apple
First, try deleting the preferences files, org.
as compared to previous generation Power Mac
mozilla.mozilla.plist and com.netscape.mozilla.
G5 desktops. The new dual-core 64-bit Xeon
Bradley Dichter
plist. There is also the possibility your cookie
chips (Woodcrest) deliver an astounding perbdichter@optonline.net
file may be damaged. That’s buried in your
formance boost.
home folder – shown as a ~ (tilde) at ~/Library/
This comes from the software developer
Mozilla/Profiles/Al Choy/randomtext.slt/cookies. – not from Apple, and it’s music to my ears. Yes,
txt. Another suggestion would be to switch to
now I have to purchase one, but after all we
the newer project called SeaMonkey 1.0.4. It has
have gone through and the questions that have
Web browsing, newsgroups, e-mail and IRC
come up, this is encouraging. For the last few
chat and HTML editing all-in-one. See www.
years it has been iPod this and iPod that. It is
mozilla.org/projects/seamonkey/.
great to know that Apple can still make a ﬁne,
fast computer. As far as I’m concerned, this is
| I have a iBook with a broken hinge on the
What to do when
left side. The AppleCare contract has just
what computing is all about. 0
plist files go awry.
expired. Is this normal?
If your favorite
I wouldn’t call it normal, but not unheard of.
application keeps
You can send it away to www.powerbookresq.
crashing, fails to
com/ for repair. It will be $200-$230 for 12"or 14"
load, or freezes
iBook G3 models. They are in Kansas, just outyour Mac, the
side of Kansas City. That’s a bit cheaper than
problem could be
Apple would charge. It’s a rather labor intensive
within your plist files.
repair.
Property list (plist)
files store specific
| I’m trying to back up my PowerBook
application settings
G4 (four-months-old) that has developed
and preferences,
problems. Where can I find Preferences and
and are usually
Caches of things I’ve downloaded, so I can
found in either the
save them. Podcasts and such?
Library/Preferences
Our Apple mavens
All
of these things are in various folders in your
Directory in the root
(caught in the act)
as they
check out the new Ap
Home folder. Your applications’ preferences are
directory of your
ple store at Smithav
en
Mall.
kept
in
the
home
folder’s
library/preferences/
hard drive, or in the
folder. You generally don’t want any cache files.
Library/Preferences
Podcasts can be found in~/music/itunes/tunes
Most notably the office 2004 Identities/Main
Directory in your
User name folder.
music/podcasts and and purchased music would
Identity sub-folder and the Saved Attachments
Plist files are listed
be in a folder by the artist’s name inside the
sub-folder. Apple’s Mail saves your mail in the ~/
according their host
~/music/itunes/itunesmusic/folder. The purLibrary/Mail/ folder. In case it is not clear, your
application: for
chased music is usually an while your other
Home folder in stored on your hard drive in the
example, TextEdit’s
music would be .mp3 format. The default for
Users folder.
plist file is named
ripping your own CDs would be AAC format,
| My PowerMac G5 had to have the software
com.apple.TextEdit.
so
the
files
would
have
a
.m4a
or
.m4b
file
reinstalled
and I reinstalled the Epson scanner
plist (The beginning
name extension. You should also know that
software with the CD it came with, but I get a
part of the name,
your iPhoto images are in your ~/pictures/iphoto
message about missing TWAIN driver? How
com.apple, indicates
library/ folder, your ~/documents folder, where
can I fix it?
the vendor that created the applicaMac OS X wants to save everything is in the
TWAIN is the scanner driver framework. The
tion.)
Home folder, and any files and folders on your
Epson installer will put in a TWAIN Data Source
Desktop is in the ~/Desktop folder, so if you
file. (It goes in the /Library/Image Capture/
backup the whole home folder, you should
TWAIN Data Sources/ folder. You forgot to go
catch all your important files. By the way,
to Epson’s Web site and download the updated
Microsoft Entourage saves all your e-mail in
software that actually works with your Mac’s
your ~/Documents/Microsoft User Data folder.
(Q&A continues on Page 3.)

Bill Medlow
President
ArchBill@optonline.net

TIPS!
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TIP!
Unformatting
Pasted Copy in
Adobe InDesign
CS2:
If you’re as bad a
typist as I am, you’re
going to love this new
feature in InDesign
CS2. You have to add
a long URL to the
end of a paragraph
of body copy. This
Web address already
exists in another
layout but using an
entirely different
paragraph style. No
problem! Just Copy
(Edit > Copy) , pick an
insertion point in your
new paragraph, and
go to Edit > Paste
without Formatting.
The URL is pasted
with the formatting of
your new paragraph.
–Jeff Witchel,
Certified Adobe
Training Provider.

existing entry for your home folder. What you’ve
just done is to create the view action that will
act on the folders in your home folder. The next
step is to customize the settings to match your
desired views.
The key to this Automator action — to change
the views on all the folders in your user’s folder,
you must check the Apply Changes to Subfolders checkbox. Once enabled, your Automator

action will run on every folder within your user’s
folder, not just the topmost one. Putting it all
together, this full-size screenshot is representative of the completed Automator action — your
version, of course, will have your home folder and
your view settings in it.
Please read this bit before proceeding!
Before you go any further, be aware that the next
step will set all folders in your user’s folder to the

settings you’ve created here. It may also take a
while to run, depending on how deep your folder
structure is. No data will be lost, but if you had
customized window settings for a folder (for
instance, a downloads folder in list view sorted
by date), those settings will be overwritten.
The last step is to simply click the Run button
and wait for Automator to finish running the
action. When it’s done, every folder in your user’s

folder will open with the settings you created.
Save your Automator action somewhere handy
for future use, just in case you want to run it
again.
What About New Folders?
When you add a folder to your user’s folder, it
won’t automatically inherit these settings – it
will keep whatever settings are presently in use.
(Continues on Page 4)

More of Bradley’s Tech Session

TIP!
Calculating the
Number of Listings
Automatically in
Adobe InDesign
CS2:
You’ve placed a
listing of products
with prices from
Excel as a table with
each item and its
price in a separate
row. There are
hundreds of listings
in your table, but how
can you ﬁgure out
the exact number
without counting
them manually?
With the Type tool
active, move your
mouse up toward
the top of the tables
column until you
get a heavy down
arrow. Click to select
this entire column.
Then take a look in
your Info palette
(Widow>Info) for
a line count which
should equal your
number of listings
(as long as there are
no empty cells). It
takes a fraction of
a second, but who’s
counting?
–Jeff Witchel,
Certiﬁed Adobe
Training Provider.

operating system. You may have to uninstall
what is there now, before installing the new
version. Apple changed things for scanners
with Mac OS 10.3. A large number of printer and
scanner drivers required updates. (Some models
were left behind and not updated. Anybody
got an old UMAX or Microtek scanner?) Pretty
much 99.9% of any hardware you might find, the
software that came with it on a disc, is out of
date and needs a update. The Software Update...
you find in the Apple menu is only good for
updating your Apple software. The third party
software like Microsoft, Adobe, Epson, HP, you
name it, all need to be updated separately. Even
firmware updates for your cable/DSL router or
your fancy printer come out every so often. You
know there have been dozens of iPod updaters,
right? Do you think anyone got it right the first
time? There is a reason the current Mac OS is
version 10.4.7, because there were problems with
10.4.0, and still more with 10.4.1, etc., up to 10.4.7
itself. There will be a 10.4.8 update. When in
doubt, go to www.versiontacker.com/macosx/ to
see if there is a software update for something
you use. You won’t find every firmware update
there, too, but some are listed. I remember
calling a friend who had just ordered some new
software but he hadn’t received it yet. After
checking Versiontracker, I told him, while
you’re waiting, download the update for it, it
fixes a serious problem. Updaters can be tricky,
too. Some are very incremental, like FileMaker
Pro 8.0v3 updater won’t update the original
release from the CD, version 8.0v1. You have to
first download the 8.0v2 updater, install that
before the 8.0v3 can find a valid application to
update. More and more programs check for
an update for themselves when they launch,
but many require you to select from a menu
to check for updates now. Some, like Adobe
Creative Suite, can check for updates across
most of the suite, but you have to check Adobe
Acrobat Pro separately.
| You’ve mentioned turning off Epson
printers when not in use to avoid clogging.
Old and new models? I heard you can’t tell
how much ink is left in the Epson printers.
That’s generally not true. Any Epson printer
that has a Mac OS X driver installed, will install
the Epson Printer Utility. With that you can
check the ink levels. Now, on the other hand,

if your printer relies on Gutenprint, formerly
known as gimp-print, then there is no Mac OS
X native way to check your ink levels. This can
be the case with a very old printer. I’ve got a
client who finally moved from Mac OS 9 to OS
X and with Gutenprint 5, I basically got her old
Epson Stylus Photo EX (via USB adapter) to
work, but the software controls were very different and she could not control the printer like
she used to, so eventually gave in to my advise
and bought a newer model that was supported
by Mac OS X, the Stylus R1800. Of course she is
much happier with the new printer. Software
aside, the new printer has a much finer dot pattern, is faster and prints far better, plus it prints
on inkjet printable CDs. Sometimes you just
have to let go. Anyway, back to the clogging
issue, both new and old models are subject to
clogging if you don’t turn them off to allow the
printer to cap the inks. Also if you don’t use the
printer often, they can clog anyway. The Canon
and HP printers use a thermal print head, so its
always squirting hot ink through the print head
which avoids clogging. In some units, the print
heads are separate from the ink tanks altogether,
which is best for servicing. I’d avoid HP all-inone printers, as their software is a major pain. 0

Starting at just $999, the entire family of
iMac computers now features the blazingly
fast, 64-bit Intel Core 2 Duo processor.
Ranging in speed from 1.83GHz to 2.33GHz,
the new family consists of a 17- and 20-inch
model and an entirely new model with a dazzling 24-inch display offering 1920-by-1200pixel resolution.
The fastest, biggest, and brightest iMac
ever, the 24-inch model comes standard with
a 2.16GHz processor and 4MB of shared L2
cache, but you can order yours with a 2.33GHz
processor to realize all the speed it’s capable of
delivering.
The 24-inch iMac comes with a builtin iSight video camera, iLife ’06, Mac OS X,
and Front Row, to enjoy your movies, music,
photos, and videos from across the room. 0
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TIP!
Tip for magazine and
newspaper editors
in Adobe InDesign
CS2:
If you’re working
on a magazine or
newspaper, you’re
working with writers;
and chances are
you’re in charge of
giving them (or at
the very least, your
editors) the word
counts for articles.
If that’s the case,
InDesign can help.
Put your text frames
in place on the page
where the article
will appear, then
go under the Type
menu and choose
Fill With Placeholder
Text to fill the text
frames with sample
text. Now all you
have to do is look at
InDesign’s built-in
word count, which is
found by going under
the Window menu
and choosing Info.
At the bottom of the
Info palette, you’ll
find the “counts,”
and the second
one down is the
word count for your
selected text. (Note:
If you don’t see this
information, it’s just
hidden. Go to the Info
palette’s flyout menu
and choose Show
Options.)
–Layers Magazine
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There are two solutions to this problem. The “big
hammer” approach is simply to open your saved
Automator action, and run it again. But this is
overkill for fixing a few folders.
Instead, open your existing action, and
delete the first action in the work area (the Get
Specified Finder Items entry). Just click once on
it, then hit delete. This leaves just the Set Folder
Views action in place. Next, select File: Save As

4

Plug-in, and give your new plug-in a name like
“Set Folder to My View” or something similarly
remindful of its functionality. Set the Plug-in For
pop-up to Finder, and click Save.
You’ve now got a new Finder plug-in you can
easily use to set the view options for a given
folder (and its subfolders, unless you removed
the subfolder option). Just highlight a folder
in the Finder, control-click on it, scroll down to

Automator, and choose Set Folder to my View
from the submenu. Presto, you’ve just changed
everything to your preferred view.
You could expand this last step, too — create
a number of different view settings, one each for
icon, list, and column view, each one set up as
you prefer. You should also probably uncheck the
Apply Changes to Sub-folders box as well, so that
you’ll take action only on the current folder. Then

just save each as a Finder plug-in, and you’ve got
a quick and easy way to set any one folder to a
customized view.
Automator is really a powerful tool that can
help you create simple tools that make using OS
X even more fun and productive than it
already is. 0

Sore Eyes

Helen and
Sheldon Gross
shel9@verizon.net
Note: Sore Eyes site
referrals are for your
information only.
Neither the Grosses
nor LIMac endorse
any of the sites or
their products.

We just got back from Merrie Olde England
where we spent two weeks meandering around
Bath and London and enjoying the World
Championship Fencing Competition in which
our son was a participant. He won the National
Competition in Foil in Georgia and went to
Bath to represent the USA. You’ll have to excuse
our parental pride since he’s been fencing for
over 35 years, and we feel he deserves a pat on
the back, to say the least. He did quite respectably, coming in tenth out of 160 foil fencers
representing over 40 nations, but he, of course,
wanted a medal. He is already planning for next
year’s competition in Australia.
This is a lead in to our computer problem.
I had written about the ﬁrst part of the trip in
a Word document, which I left on my desktop.
A couple of days later, I opened the document
and wrote about the second part of the trip. All
of a sudden the document disappeared and a

window opened that said something like: Do
you want to save the original document? Yes or no.
I hit yes, like a fool, and there was the original
document sans the second half that I had just
written. I have been looking for it all over the
hard drive but can’t ﬁnd it. Is it on my computer,
somewhere? If so, how do I ﬁnd it?
Anyone have any ideas? I’m open to all suggestions.
Just one final note about traveling: Never
forget that public libraries all over the world
usually have computers available to let you pick
up your e-mail and send messages, etc. We’ve
done research and answered our problems in
many places, both in the US and abroad. The
most fun comes when you try to get used to a
keyboard in a foreign language. Iceland was the
best with at least seven extra keys, but even in
England it was a challenge to find the @ key.  0

User Group News

George Canellis
gwc11713 @ optonline.
net

Drag-and-drop
disk-image creation:
Using Disk Utility
(/Applications/
Utilities), you can
create a disk image
– a sort of virtual hard
drive – from any
folder in OS X. I use
disk images for quite
a few things: Classic

LIMac is a proud member of the Peachpit User
your hard drive); Picture Rescue (digital picGroup Partner Program and as such all LIMac
ture recovery); Data Backup (backup made
members are entitled to a 30% discount off
easy); Data Rescue (emergency file recovery);
the list price of any of Peachpit’s books. When
and TuneTech for iPod (maintain, manage and
ordering at their Website (www.peachpit.com)
optimize your iPod. (www.prosofteng.com)
at checkout, right before you enter your credit
| Delicious Library. (25% Off)Rediscover your
card number, you must enter the user group
home library with Delicious Library. Point
coupon code UE-23AA-PEUF (case-sensiany digital video camera (like Apple’s iSight)
tive). This coupon code is an exclusive offer
at the barcodes on the backs of your books,
that may not be used in conjunction with any
movies, music and video games, and Delicious
other coupon codes. Through the generosity
Library does the rest. The barcode is scanned
of Peachpit, LIMac will also be receiving free
and within seconds the item’s cover appears on
books as raffle prizes. Look for them in the
your digital shelves, filled with the informanear future on the prize table when you’re
tion downloaded from Web sources around
purchasing your raffle tickets at the monthly
the world. Regularly $40 (US), Delicious
meeting.
Library is now available for $30 (US) for Apple
The following vendor offers require a topUser Group members.This offer is valid
secret user group offer code. If you are interthrough November 30, 2006. (www.deliciousested in any of the following products, please
monster.com)
send an e-mail to me at gwc11713@optonline.net. | Miglia Technology offers Apple user group
(AUG) members 20% discounts on its video
| Prosoft is dedicated to creating professional
quality software designed to be easily used by
and audio products. If you are interested in
both novice and expert users. Prosoft adopts the watching, recording, pausing or rewinding
role of being data advocates, fighting to prelive TV on your Mac, then Miglia’s TVMicro,
serve data and prevent data loss. Prosoft offers
TVMini HD and TVMax are for you. If you are
a 25% discount to all MUGs using the special
more into audio, check out Harmony Audio
MUG discount code. Their products include:
and Harmony Express! This offer is valid
Drive Genius (maintain, manage and optimize
(User Group News Continues on Page 6)
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lives on a compressed disk image
on my Mac. I make
disk images out of
game CDs – you can
play some, but not
all, games with the
disk image mounted
instead of having
the original CD in the
drive. I also keep a
FileMaker Pro database of passwords
and other sensitive
information on an
encrypted disk image,
which I can travel
with, with some
degree of security.
Want to avoid the
tedious process of
opening Disk Utility,
selecting Image:
New: Image from
Folder, and then navigating to the folder
you want to turn into
a disk image? You
can. Drag-and-drop
disk-image creation
disappeared from
OS X 10.3 but quietly
returned to OS X
10.4.
Now, just drag
your folder onto the
Disk Utility application icon – whether
it’s in the Dock, the
Finder, or the Finder’s
sidebar or toolbar.
Disk Utility will
launch, displaying
the New Image From
Folder dialog box.
Select an image
format (options
include Compressed
and Read-Only), and
then decide whether
you’d like to encrypt
the image so only you
can open it. That’s it!
–Rob Griffiths
Kirk McElhearn

Keep your receipts:
The next time you buy something online, don’t bother to jot
down the confirmation on an
easy-to-lose sticky note. In OSX
10.4, press Command-P when
the site displays the receipt. In
the Print dialog box that appears, click on PDF
and select Save PDF to Web Receipts Folder

TIPS!

from the drop down menu. OS X creates a PDF
of your receipt and saves it in your user folder/
Documents/Web Receipts.
–Joe Kissel
Shrink PDFs with Preview:
Some PDF files – particularly those with graphics
– can be too big to send via e-mail or download
over a dial-up connection. Sure, you can buy a

tool that shrinks PDFs, but Preview 3 may be all
you’ll need.
Open a PDF in Preview and choose File/save
as. In the Save dialog box, give the file a new
name. Then choose Reduce File Size from the
Quartz Filter pop-up menu and click on Save.
When I exported a photo-heavy calendar as
a PDF file from iPhoto, Preview reduced its size
from 10.4 MB to an e-mail-friendly 828K.

Some caveats: Reduced files may not display
or print as clearly as the originals, bookmarks
are lost, and PDFs that have already been optimized or that are quite small may grow in size.
But Preview makes tasks such as slimming an
iPhoto book layout before sending it to a relative
easy and free. –Adam C. Engst
Don’t miss Adam’s presentation at our
October meeting!

Typographic Visual Alignment

Ilene Strizver
Ilene @ thetypestudio.com
Ilene Strizver, founder
of The Type Studio,
is a typographic
consultant, designer,
writer and specializing in all aspects
of typographic communication, from the
aesthetic to the technical. Ilene conducts
Gourmet Typography
Training internationally. For more information, visit www.
thetypestudio.com.

Visual alignment (also called optical aligment)
means exactly that: using that high-tech tool,
the human eye, to line up your text until it
looks right.
Vertical alignment
Many computer users are surprised to discover that using numerically consistent leading
(or line spacing) does not assure visually consistent vertical spacing between lines of type. This
is typically an issue when setting three or more
lines of display type.
For example, if a line of type is all caps, it has
no descenders. This creates more white space
below it. An all caps line also has a taller height
than lines with mostly lowercase characters, creating less white space above it. This is a perfect
example of the need for visual alignment: adjust
the spacing above and below all cap lines until it
looks right, regardless of what the numbers say.
Similarly, in cases where lines with lots
of ascenders and/or descenders are preceded
or followed by lines with few or no ascenders

The spacing of certain characters, such as a
cap T or A or the numeral 1, as well as periods,
commas, apostrophes, dashes and quotations
marks, create a visual hole or indentation in the
beginning or end of a line relative to the characters above and below.
This problem is most noticeable in larger
settings such as headlines, subheads and initial letters. To solve it, move the line in or out
until it visually aligns. (Depending upon your
software, there are various ways to do this.) It’s
helpful to look at your text from a slight distance when correcting problems, since it can be
difﬁcult to know how much of an adjustment
is enough. When in doubt, less is more. Don’t
try to adjust small-sized type or large blocks of
text; it’s too time-consuming and the results are
barely visible at text sizes.
NOTE: On screen, italic text almost never
seems to align horizontally, especially when
centered. This is usually an optical illusion, so
beware of making too many adjustments here
(if any at all!), or you will wind up with all of
your copy askew!
Setting type on your computer makes it a
no-brainer to create typography with technically consistent spacing, but always, always,
always use your eyes as the ﬁnal arbiter of good
alignment.
Designers are used to being detail-oriented
and mathematically precise, nudging things a

A capital T makes the top line appear to be slightly indented
(upper). Pulling the top line out slightly to the left makes this text align
visually (lower).

and descenders, the lines will appear to have
varying spacing even if the leading is exactly the
same. Use visual alignment to adjust the leading
between the lines until they look equidistant
from each other.
Horizontal alignment
Visually “off” horizontal alignment can
happen in both text and display type and is
most easily apparent in ﬂush left, ﬂush right
or justiﬁed copy. Why? Your computer aligns
characters (including punctuation, ﬁgures and
symbols) by the edge of the character plus its
sidebearing (that’s the built-in space that surrounds a letter and is actually part of its design).

The text on the left is set in a consistent 21/23, but the middle lines look
too tight. When the leading on the right is adjusted to 21/22, 21/27 and
21/22, the lines looks even.

point this way and a pixel that way until technical perfection is achieved. However, when
it comes to typographic alignment, the mathematical approach to design doesn’t apply: it’s
all in the eye of the beholder. 0
Pay your 2006 dues now!
Send your $36 check to:
Long Island Macintosh Users Group,
Post Ofﬁce Box 2048.
Seaford, New York 11783-0180 0
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LIMac’s Privacy
Policy:
General Information
Collection: LIMac
acquires mailing and
e-mail addresses
from our members
and no other outside
sources in order to
communicate with
our membership. We
use this information
to send out the LIMac
Forum and to send
occasional notices.
Disclosure to Third
Parties We do not
disclose mailing
addresses, e-mail
addresses or any
other confidential
information to third
parties.
Questions If you
have any questions
concerning LIMac’s
Privacy Policy, please
e-mail them to aboutlimac@aol.com. 0
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Let ’em know you’re a LIMac member!
Our Famous LIMac logo is now available
to be embroidered on any wearable item.
High-quality embroidery is done by ACU
Plus Custom Embroidery, located at 3700
Hempstead Turnpike, Levittown, NY 11756;
(516) 520-1039.
www.acuplusembroidery.com/index.html. 0
What to do when
plist files go awry:
If your favorite
application keeps
crashing, fails to load,
or freezes your Mac,
the problem could be
within your plist files.
Property list (plist)
files store specific
application settings
and preferences,
and are usually
found in either the
Library/Preferences
Directory in the root
directory of your
hard drive, or in the
Library/Preferences
Directory in your
User name folder.
Plist files are listed
according their host
application: for
example, TextEdit’s
plist file is named
com.apple.TextEdit.
plist (The beginning part of the
name, “com.apple,”
indicates the vendor
that created the
application, insuring
that no two plist files
will have the exact
same name.) If you
have a problematic
application, you may
have a corrupt plist
file. Here’s what you
can do.
Start anew: Remove
the application’s plist
files. The next time
you launch that app,
new plist files will be
created with default
application settings.
Presumably, a new
file will no longer
have the corrupted
data of the original
file, thereby eliminating the problem.

(User Group News Continues from Page 4)
through October 31, 2006. (www.miglia.com)
| myNotes is a human-friendly, note-taking
program to create and organize notes and
clippings, and print them utilizing beautiful
customizable themes. It is one of the easiest
Macintosh note managers while offering an
extended set of unique features. With myNotes’
Address Book integration, you can look up contacts by first or last name, then send e-mail,
start a chat session or access their homepages
with just one click! Regularly $15.95 (US), Apple
User Group members can purchase myNotes for
$11.95 (US) for a limited time.This offer is valid
through November 30, 2006. (www.mishimo.
com).
| Get DiscLabel, the award-winning software
for designing CDs, jewel boxes and DVD packaging, fully-integrated with iTunes and iPhoto
for effortless importing of track information
and images. Printing is foolproof – DiscLabel
supports all label brands, plus direct-to-CD
printers and LightScribe. Regularly priced at
$29.95 (US), Apple User Group members pay
only $22.46 (US), a 25% discount. Valid until
November 30, 2006. (www.smileonmymac.com)
| Adam and Tonya Engst of TidBITS are
continuing their fourteen years of supporting
user groups with a special 10% discount for all
orders in their new Take Control electronic
book series. Take Control ebooks provide highly
practical, tightly focused, inexpensive help from
leading Macintosh authors. Titles are delivered
in PDF layout with active links, and are optimized for viewing and printing. (www.tidbits.
com/takecontrol)
| RadTech is your source for the very best
in mobile computing and iPod products and
accessories for care, protection and productivity. A full line of award-winning, innovative
products made with Optex material are offered:
ScreensavRz (the total-care LCD display protector), Sleevz for iPod (play directly through
the case) and Sleevz for Notebooks (stylish
protection). Apple User Group members receive
a 20% discount. This offer expires October 31,
2005. (www.radtech.us)
| Apple has determined that certain lithiumion batteries used in select iBook and PowerBook computers could overheat under rare
circumstances posing a safety risk. The models
affected include the 12-inch iBook G4, 12-inch

…And don’t
forget to pay your 2006 dues now!
Send your $36 check to: Long Island Macintosh Users Group,
Post Ofﬁce Box 2048, Seaford, New York 11783-0180.0
PowerBook G4, and 15-inch PowerBook G4.
If you’re using one of the notebook models
identified, please visit their Website to see if
your battery falls within the serial number
ranges of affected models. Apple has initiated
a voluntary battery-recall program to replace
batteries – free of charge – to those eligible to
participate.
| In a time when we find our student populations becoming easingly diverse and learning
differences more apparent, Apple provides
technology tools to support the best learning
environment for all students regardless of their
learning differences. These tools can engage
all students, enhance their achievement, and
inspire them to work harder.
At the heart of Apple’s solutions for students with learning differences is the easy to
use operating system that enables students to
access content for learning and to become producers of knowledge. Powerful, built-in accessibility features offer options such as VoiceOver,
QuickTime Text Track, Speech Recognition, Textto-Speech Synthesis, and other tools for accessibility that can be adapted to meet the unique
needs of each learner. Apple refers to these features collectively as Universal Access.
We know that today’s digital kids need a
different set of tools to be successful and
engaged in learning. At the same time, all
students – and particularly those with learning
differences – need tools that will allow them to
express themselves in creative, flexible ways and
in the modality that best meets their needs.
When students are offered these tools, they
suddenly find ways to express themselves that
go beyond the limitations of paper and pencil.
We find students who are deaf collaborating
with iChat AV, students with learning disabilities using iPhoto to create stories, and students
who are blind producing iMovies to share their
perspective of the world.
Apple’s iLife applications, together with
tools such as iChat AV, iPod, and iSight cameras
offer new and multiple pathways to learning
that take into consideration physical requirements, learning disabilities, learning styles,
intelligences, and interests. Aligned with best
practices for teaching and learning, Apple’s digital tools ensure that the needs and preferences
of each learner can be optimized. 0
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Check for intruding
apps: In some
instances, more than
one application may
be writing to a plist
file. For example,
Safari’s plist is often
used by Apple’s
Mail. If you are experiencing repeated
corruption of the
com.apple. Safari
plist file or another
plist file, investigate
the other applications that could be
writing to the file. To
do this, navigate
to the plist file that
you want to inspect,
select its icon, and
press Command-I on
your keyboard. Next,
launch some of your
routine applications
and check to see if
the Get Info window
closes – this tells
you that the app
you just launched
is using that plist
file. Reinstall – or
consider replacing
– the offending application.
–MacFixit

LIMac E-mail
Address Updates:
Some people have
changed servers
(so our e-mails
bounce back). If
you have an e-mail
address and have
not been getting our
reminders, please
e-mail aboutlimac@
aol.com (Donald
Hennessy) and use
“LIMac e-mail update”
as the subject.

